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RESUMEN

El mezquite (Prosopis laevigata) es un recurso natural importante para
poblaciones de zonas aridas del pais ya que todas las partes que lo constituyen
(madera, semillas, raices), lo convierten en un recurso natural importante como
alimento humano y del ganado, tiene un uso medicinal, agropecuario, artesanal y
combustible. Por esto, en muchas areas del pais su densidad poblacional se ha
visto reducida severamente y la sobre explotacion de este recurso es causante de
la deforestacion y una irreversible pérdida de diversidad genética por lo que es
necesario realizar un uso adecuado, manejo y propagacion para la conservacion
del mezquite. Debido las dificultades y prolongado tiempo que se requiere para la
propagacion in vitro y el enraizamiento del mezquite, en este trabajo se evalud la
transformacion de sus raices con Agrobacterium rhizogenes K599 en adicion de
AIB en dosis minimas de 3 PPM para asi inducir y mejorar la formacion in vitro de
sus raices. Cien plantulas de mezquite de 2 semanas de edad a las que se les
corto la raiz se dividieron en 4 lotes: A) Control, B) A. rhizogenes, C) AIB 3 ppm,
D) A. rhizogenes + AIB 3 ppm. Tras 2 meses posteriores al inicio del tratamiento
se registraron los parametros morfoldégicos, biomasa, longitud de raices, area foliar
y se corroboro la transformaciéon de las raices mediante la amplificacion y
secuenciacion del gen rolB. El tratamiento que mejores resultados mostro respecto
al control, para los parametros enraizamiento, biomasa, longitud y nimero de
primordios fue el correspondiente al lote D, donde la combinacion de la bacteria y
ABB 3PPM mostr6 un 100% de enraizamiento y obtuvo 427% mas biomasa,
desarrollo 287% mas longitud y 475% mas primordios. Seguido por los
tratamientos del lote B y C, en donde a pesar de las altas tasas de enraizamiento,
biomasa y longitud obtenidas, no se encontraron diferencias significativas entre los
tratamientos que utilizaron en forma separada la induccién mediada por A.
rhizogenes o por auxina exdgena. Mediante una extraccion de ADN en las raices
tratadas con la bacteria se encontr6 una secuencia con un 100% de identidad al
gen rolB de A. rhizogenes. Sin embargo a pesar de descartar la contaminacion
residual en el Control, se obtuvo una secuencia con solo dos cambios de bases a
lo largo ésta con una identidad del 99% con una region del plasmido Ri de A.
rhizogenes.
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INTRODUCCION

Generalidades del Mezquite

Las especies del género Prosopis son conocidas comunmente con el nombre de
mezquites y tienen una distribucion amplia que va desde Asia y Africa y se
extiende por América desde Estados unidos hasta Argentina. En nuestro
continente es un género caracteristico de zonas xerofitico-secas (Antezana, et al.,
2000). En México, el mezquite (Prosopis laevigata) es un arbol endémico que
forma parte de la flora en zonas aridas y se clasifica dentro del tipo de vegetacién
de “matorral mediano espinoso o bosque caducifolio espinoso” y sus comunidades

son frecuentemente llamadas mezquitales (Rzedowski, 2001).

Este arbol pertenece a la familia de las leguminosas y puede alcanzar hasta los 12
metros de altura, su corteza es gruesa y de color café, sus ramas son glabras con
espinas, las hojas son bipinnadas, cada una con 10 a 20 pares. Sus flores son de

color amarillo y su fruto es una vaina dura de color café amarillento (Rojas, 2007).

Este se encuentra principalmente en la vertiente del pacifico desde Michoacan
hasta Oaxaca y en la del Golfo de México en Nuevo Ledn, Tamaulipas, Veracruz y
en las regiones centrales de altura del pais hasta los 2,300 m.
Preponderantemente en San Luis Potosi, Guanajuato, Zacatecas, Durango,
Coahuila e Hidalgo (Gomez et al., 1970). Pero P. laevigata también es muy

abundante en el valle de Tehuacan-Cuicatlan Puebla (Arias et al., 2000).

El nombre mezquite proviene de la palabra azteca de origen nahuatl para nombrar
arbol “misquitl”. Quiza el primer espafol que hablara del uso del mezquite por los
indios fue el explorador Alvar Nufiez Cabeza de Vaca, al resefiar la exploracion
que hiciera Panfilo de Narvdez a Florida en 1528 a 1536 junto con tres
compafieros que viajaron cautivos a través de Texas y a lo largo del Golfo por la

parte de Texas con las tribus de indios del suroeste (Villa y Bérquez, 2006).
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Importancia

Las comunidades de mezquite juegan un papel importante en el mantenimiento
del balance ecolégico en ecosistemas aridos, proveyendo refugio y comida a una
amplia variedad de animales (Mares et al., 1977). Ademas este arbol funge como
nodriza de algunas especies de cactidceas como Neobuxbaumia tetetzo. La
relacion entre estas dos plantas es considerada esencial para el desarrollo de la
cactacea, ya que gracias al nodrizaje la supervivencia de plantulas de N. tetetzo
es mayor dado que P. laevigata confiere condiciones ambientales ventajosas
como menor radiacién solar, temperatura, evaporacion del suelo y mayor
disponibilidad de nitrégeno (Santiago, 2003). Ademas, el mezquite forma islas de
recursos y actia como indicador de profundidad del manto freatico (Cervantes,
2002), forma parte del equilibrio ecolégico de los desiertos mexicanos ya que
cuenta con un sistema de raices profundas, que participan en la conservacion del
suelo y del agua. Ademas por ser una leguminosa, contribuye a la adicién de

nitrogeno al suelo (Orozco, 1996).

El mezquite es considerado como un recurso natural importante para algunas
poblaciones de las zonas aridas y semiaridas, ya que sus hojas y vainas sirven de
alimento para el ganado y la alimentacion humana. De la corteza se extraen
curtientes, la madera es utilizada para duela, madera aserrada, mangos de
herramientas, hormas para zapatos, extraccion de gomas y taninos. En la
medicina tradicional se utiliza como vomitivo y purgante, la resina se ha empleado
como tratamiento de disenteria y algunas afecciones de los ojos (Gomez, 1970;
Pennington et al., 1998). En el Valle de Tehuacan-Cuicatlan, la lefia representa
una fuente importante de energia doméstica, ya que 36% de la poblacién la utiliza
como unico combustible, 44% utiliza lefia y gas Yy soOlo 20% utliza gas

anicamente (Arias et al.,, 2000; Garcia y Tapia, 2007).

Debido a esto, en muchas areas del pais la densidad poblacional del mezquite se
ha visto reducida severamente, la sobre explotacion de este recurso es causante

de la deforestacion y una irreversible pérdida de diversidad genética (Buendia et
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al., 2005). Ademas a este arbol se le considera como una especie indeseable ya
que compite con especies forrajeras que crecen en las regiones aridas. A
principios de los afios cuarenta, bajo el concepto de pastizal puro, los ganaderos
empezaron a ver en el mezquite una plaga que debia ser eliminada de los
pastizales en los que criaban a su ganado y junto con la expansién urbana
provoco la destruccion de muchos mezquitales (Zepeda et al., 1999). Debido a
estas razones es necesario realizar un uso adecuado, manejo y propagacion para
la conservacion del mezquite. En planes de un uso sustentable, es importante
seleccionar individuos elite, propagarlos y establecer plantaciones de estos

individuos para asi evitar la disminucion del recurso (Buendia et al., 2005).

En 1964, la Food and Agriculture Organization (FAO) sugirié el uso del mezquite
para la reforestacion de zonas aridas y semiaridas (Goor, 1964). En 1979, esta
organizacion inicié el proyecto de exploracion, coleccion, evaluacién, conservacion
y utilizacion de varias especies de arboles para usos multiples, dando prioridad al
género Prosopis (Ffolliot et al., 1983). Sin embargo, el cultivo de una gran variedad
de especies arbéreas de importancia econémica requiere de tiempos prolongados
debido a que por lo general el ciclo de vida de éstos es muy largo (Jones, 1983), y
la propagacion sexual es la via mas comun de obtener nuevos ejemplares de
algunas especies del genero Prosopis en viveros, pero lamentablemente muchas

caracteristicas forestales deseadas se pierden de esta manera (Caro et al., 2000).

Propagacién

La propagacion vegetativa de material juvenil es facil en la mayoria de las
especies arboreas, pero el enraizamiento se vuelve mas dificil con el incremento
de la edad como lo es el caso del mezquite, pero dentro de un mismo arbol existen
zonas que mantienen mas tiempo la juvenilidad y pueden ser estimulados a para
la produccion de material vegetativo fisioldgicamente juvenil (White et al., 2007).
Dentro de las hormonas reguladoras de crecimiento, se encuentran las auxinas
que son las que presentan mayores efectos en la formacion de raices adventicias,

siendo las hojas jovenes y yemas activas, la principal fuente de auxinas
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enddégenas, que permiten la rizogénesis en ausencia de auxina exdégena
resultando mas efectivas en la induccion rizogénica que la auxina natural
(Hartmann et al., 1997).

Se presenta entonces la alternativa de micropropagacién como técnica capaz de
conservar las caracteristicas deseables de individuos seleccionados por sus
caracteristicas fenotipicas. La micropropagacion de los individuos seleccionados
posibilitaria entonces una propagacion vegetativa con rapida ganancia de
caracteres génicos deseables en programas de mejoramiento forestal (Caro et al.,
2002).

Empleando técnicas de cultivo de tejidos, propias de plantas herbaceas para la
propagacion vegetativa se han logrado obtener buenos resultados para este
mismo fin con especies maderables (Jones, 1983). Las técnicas de propagacion
masiva de diferentes especies con interés comercial, biotecnologico y ecoldgico

ofrecen ventajas con respecto a las convencionales.

El cultivo de tejidos vegetales ofrece alternativas importantes en cuanto a la
propagacion de materiales seleccionados, pudiendo obtenerse caracteristicas
genéticas homogéneas, evitar la diseminacion de patdgenos presentes en el suelo
y producir masivamente las plantas requeridas. Comparando la micropropagacion
con las técnicas de propagacion tradicional, se tiene la ventaja de que se puede
obtener un mayor nimero de plantas en menor tiempo y espacio a manera de un
proceso continuo que no se ve afectado por las variaciones ambientales y
estacionales (Bergmann et al., 1994). Dentro de este contexto, estas técnicas
ofrecen una alternativa real de micropropagacion para una planta como P.
laevigata (Orozco, 1996), la cual tiene practicamente un uso generalizado de
todas las partes que lo constituyen (madera, semillas, raices, etc.), lo que la
convierte en un recurso natural muy importante como combustible, medicinal,

alimenticio, artesanal, agropecuario, etc. (Garcia etal., 1986).

10
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Transformacion de raices mediada por Agrobacterium rhizogenes
La transformacion genética de especies vegetales es un mecanismo que hoy dia
es ampliamente utilizado dentro del campo del fitomejoramiento ya que este
sistema permite insertar genes foraneos dentro de un tejido vegetal para la
creacion de plantas genéticamente modificadas, conocidas también como plantas
transgénicas (Potrykus et al., 1998). Una alternativa, para tratar de resolver el
lento crecimiento y reproduccion masiva de algunas especies es la transformacién
genética mediada por la bacteria de Agrobacterium rhizogenes (Rodriguez, 2002),
que confiere a las plantas transformadas ventajas tales como crecimiento
acelerado e indefinido, no requieren la aplicacion exdégena de auxinas, son mas
sensibles a los reguladores del crecimiento, crecen mas rapido y se pueden
mantener creciendo indefinidamente, incluso en especies que normalmente no lo
hacian (Tiwari y Adholeya, 2002).

A. rhizogenes es una bacteria que se encuentra en el suelo es Gram negativa,
fitopatdbgena causante de la enfermedad en raices de plantas dicotiledéneas,
llamada “hairy roots” (Figura 1) o raices en cabellera (Zupan et al., 1995; Nilsson
et al., 1997). Esta enfermedad da lugar a la proliferacion anormal de las raices en
plantas infectadas y un incremento notable en la produccion de pelos radicales
(Dandekar, 1992).

Figura 1. Raices de zanahoria transformadas con A. rhizogenes. A) Formacion de
callos después de dos semanas del co-cultivo. B) Produccién de raices tras cuatro
semanas de co-cultivo (Gomez, 2010).

11
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Este desarrollo anormal de las raices en las plantas infectadas se debe a la
transferencia, integracion y expresion de un segmento del ADN bacteriano (T-
ADN), el plasmido Ri (Root inducing) (Christey, 2001). El plasmido Ri contiene
entre otros genes, los implicados en la sintesis de auxinas (Rodriguez, 2002), y
otros 4 tipos de compuestos de carbono de bajo peso molecular llamadas opinas
(agropina, manopina, cucumopina y mikimopina) (Savka et al., 1990). Como
consecuencia de ese desbalance hormonal, las células transformadas proliferan
desordenadamente y la expresion de los genes conducen a la produccion de

raices en cabellera en la regién donde se produjo infeccion (Rivas, 2007).

El plasmido Ri de A. rhizogenes contiene dos regiones (en cepas del tipo
agropina): la regién T-ADN_ (izquierda) la cual contiene 18 marcos de lectura
abierta, de los cuales el 10, 11, 12 y 15 corresponden a los llamados genes rolA,
B, C y D. Estos genes son los responsables de la enfermedad conocida como raiz
en cabellera, ademas de incrementar la respuesta a reguladores de crecimiento
por parte de los tejidos transformados, y la region T-ADNg (derecha) la cual porta
los genes para la biosintesis y catabolismo de la agropina, y dos genes en los loci

Tms para la sobreproducciéon de auxinas (Van der Salm et al., 1996).

El gen rolB aumenta la “sensibilidad™ a las auxinas en las plantas transformadas,
por lo que es este gen es el responsable de la formacion de la raiz pilosa. El
producto del gen rolB tiene la capacidad de liberar auxinas por medio de la
hidrélisis de: complejos auxinas-proteinas (se libera triptéfano), conjugados
auxinas-aminodcidos (aspartico y glutdmico) y glucésidos auxinas-azlcares
(Inositol, d- glucanasa y arabinasa) con actividad de indoxil-3-glucosidasa (Stomp,
1992). La expresion del gen rolB bajo el control de su propio promotor se da de
manera preferencial, en los apices y regiones de mayor division celular de la raiz.
En 6rganos maduros la expresion del gen rolB se da en el tejido vascular (Tempé,
1989).

12
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Para que el proceso de transferencia del T-ADN a la célula vegetal tenga lugar
(Figura 2) es necesario que la planta hospedera tenga una herida y las células
vegetales dafiadas (las cuales son consideradas como inductoras de la respuesta
de virulencia) sinteticen una serie de compuestos que inducen la expresion de los
genes vir (Bolton et al., 1986). Se trata de derivados de aminoacidos, azicares y
una serie de compuestos derivados del metabolismo del fenipropandico y una
serie de metabolitos secundarios que producen las células dafiadas (Aird et al.,
1988). La regidén vir contiene aproximadamente 25 genes, que codifican
proteinas que promueven la transferencia de otra region del plasmido Ri de la
bacteria hacia la célula infectada y se integra en forma estable al genoma vegetal
(Rivas, 2007). La induccién de los genes vir de Agrobacterium implica que
el sistema de reconocimiento de la bacteria detecte los compuestos fendlicos
producidos por la planta y transmita la informacion al interior de la célula
bacteriana. El sistema de dos componentes (VvirA - virG) de Agrobacterium, percibe
sefales especificas, donde virG es activado e induce la transcripcion de la region
vir del plasmido, generandose una copia movil del T-ADN y la formacién del
complejo transportado por virB - virD4 y la transferencia de la cadena T hacia la
célula hospedera, formandose la cadena T madura. Posteriormente, el complejo T
es importado hacia el nacleo, facilitado por proteinas del mismo hospedero, para
su posterior integracion en el genoma de la célula hospedera, mediada por virD2

o VirE2 y otros factores de la célula hospedera (TZfira, 2002).

Las células transformadas de la raiz biosintetizan su propio acido indolacético
(AlA), lo cual permite a las raices tener una tasa de crecimiento mayor respecto a
las raices normales, debido principalmente a su gran capacidad de ramificacion,
demas tienen la cualidad de crecer in vitro en ausencia de reguladores de
crecimiento exdgenos. A partir de las raices transformadas es posible obtener
plantas transgénicas completas que son al igual de las raices que derivan,
genéticamente estables (Benitez, 2005), debido a que las raices transformadas
serian usadas como explantes para la regeneracion de brotes transgénicos por la

via de la organogénesis (Christey, 2001).
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Célulavegetal
hospedera

Agrobacterium rhizogenes

Plasmido Ri
200,000 pb

Figura 2. Mecanismo de accion de A. rhizogenes: 1-Las heridas en la célula vegetal
liberan azucares y metabolitos; 2-Los azucares y compuestos fendlcos como
acetosiringona activan los genes vir; 3-Genes vir sintetizan una cadena sencilla de T-ADN
con los genes rol; 4-Transferencia de T-ADN; 5-El complejo de T-ADN se importa e
integra al ADN de la célula hospedera; 6-Sintesis de Axinas y Opinas; 7-Auxinas y Opinas
promueven la sintesis de “hairy roots” en células infectadas con A. rhizogenes.

(Modificado de Stanton, 2003).

La transformacion mediada por A. rhizogenes se ha convertido en una importante
herramienta en la industria biotecnolégica de plantas, puesto ha permitido acelerar
la velocidad de transferencia de nuevos caracteres a especies en las que, como
ocurria. con las arboreas, los programas de mejora tradicional se veian
entorpecidos debido al prolongado periodo de tiempo necesario para la

regeneracion de plantas adultas aptas para la reproduccion (Benitez, 2005).

La alta tasa de transformacion de raices de ésta bacteria ha permitido que la
produccién de plantas compuestas (plantas en las que las células de la raiz estan
transformadas por el gen de interés pero no asila parte aérea) tanto de manera in
vitro y ex vitro sea una herramienta Util para investigar funciones de algunos genes

en la raiz (Crane etal., 2006).
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Las raices transformadas han tenido un papel muy importante durante muchos
afios en la agricultura, el comercio y el ambito cientifico. Por ejemplo, cultivos de
raices han sido extensamente usados en la nodulacion de raices (Quandt et al.,
1993), produccion artificial de semillas (Uozumi et al., 1997), como sistemas para
estudiar rutas bioquimicas (Braun et al., 2002), las respuestas a diferentes
productos quimicos (Downs et al., 1994), estudiar interacciones con otros
organismos como nematodos (Mugnier et al., 1997), han  proporcionado
beneficios en la produccién de metabolitos secundarios que incluyen terpenos,
alcaloides, antocianinas y polifenoles (Xie et al., 2000) y sobre todo en la
asociacion simbiotica e interaccién con hongos micorricicos arbusculares (HMA)
(Estrada et al., 2006). Al modelo de colonizacién in vitro en medios gelificados, en
donde se encuentran creciendo en forma dual una raiz y un HMA, es a lo que se le

conoce como Cultivos monoxénicos (Hildebrandt et al., 2002).

La transformacion de raices mediada por A. rhizogenes ha sido descrita para un
gran nimero de leguminosas tales como Lotus corniculatus (Petit et al., 1987),
Trifolium repens, (Diaz et al., 1989), Trifolium pratense(Diaz et al., 2000), Vigna
aconitifolia (Lee et al., 1993), Glycine max (Cheon et al., 1993), Vicia hirsuta
(Quandt et al., 1993), Lotus japonicus (Stiller et al., 1997), Medicago truncatula
(Boisson-Dernier et al., 2001), Sesbania rostrata (Van de Velde et al., 2003) y
varias especies de Phaseolus (Estrada et al., 2006). Algunas de estas han sido el
centro primario para el mejoramiento de la informacion y los recursos genéticos
iniciando estudios gendmicos debido a que a nivel mundial tienen una importancia
econdmica. Ademas, la infeccion con A. rhizogenes puede mejorar el
enraizamiento de especies lefiosas recalcitrantes (Damiano et al., 1998). Usando
diferentes cepas de Agrobacterium, diversos autores han logrado enraizamientos

exitosos en especies tales como Pinus, Larix, Eucalyptus (McAfee et al., 1993).

La propagacion asexual de especies leguminosas lefiosas, en particular la de
género Prosopis ha llegado a ser dificil y erratica debido a factores tales como la

variabilidad en intensidad de luz, temperatura, las diferencias entre juveniles o
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adultos, adicion de hormonas exdgenas y enfermedades (Felker et al., 2005). Sin
embargo la propagacion vegetativa es factible en diversas especies de mezquite
(Felker, 1998). Mediante esquejes, acodo y distintos tipos de injerto son tratadas
con hormonas promotoras del enraizamiento como el acido 3-indolbutirico (AIB)
obteniendo buenos resultados a 100 ppm (Olvera, 2006), 6000 mg/l y el &cido
naftalenacético (ANA) 9000 mg/l que han dado resultados satisfactorios en

condiciones de ambiente controlado (Osuna et al., 2003).

Debido a que en la propagacion vegetativa con hormonas usan grandes
cantidades de éstas, el efecto de enraizamiento podria verse disminuido o inhibido
por la propia maquinaria enzimatica de la planta, la enzima &cido Indolacético -
oxidasa (AlA- ox), que degrada parte de estas hormonas tal como Riov y Epstein
(1998) demostraron que las velocidades de degradacion para AIA y AIB son
similares en Phaseolus mungo. Esto debido a un posible proceso de conversion
de AIB a AIA (Woodward et al., 2005).
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ANTECEDENTES

Con el fin de optimizar la transformacién de raices, Blanco y colaboradores (2003)
inocularon con A. rhizogenes A4TC secciones de zanahoria co-cultivadas con
acetosiringona y floroglucinol y una combinacién de ambos, mostrando una mayor
eficiencia en la transformacion (75%) con el tratamiento de acetosiringona 100 mM

en combinacién con floroglucinol 25 mg/L a los 6 dias de co-cultivo.

Mugnier y Mosse (1987) aprovecharon las caracteristicas de A. rhizogenes, para
formar raices pilosas de Daucus carota L. Las raices de las plantas infectadas
presentaron un desarrollo indefinido, ademas del incremento a la sensibilidad de
los tejidos transformados a los reguladores del crecimiento. Las raices
transformadas de zanahoria fueron utiizadas como hospedero de Glomus

mosseae Yy Gigaspora.

Chavez y colaboradores (2003), regeneraron plantas transgénicas de Citrus
aurantium L. a partir de raices transformadas con A. rhizogenes cepa A4 con el
pldsmido ESCA4, el cual lleva el gen marcador de seleccién nptll bajo el control del
promotor y terminador nos y el gen reportero de gus bajo el control del promotor
cab y el terminador ocs. Para obtener las raices transformadas se co-cultivaron,
por 96 h, segmentos internodales de tallo de plantulas germinadas in vitro, asi el
91% de los explantes produjeron raices transformadas. Para la regeneracion de
brotes se cultivaron segmentos de raiz transformada en medio con 5.0 mg/l de
benciladenina y 1.0 mg/l de acido naftalenacético (ANA) donde el 18% de los

segmentos de raiz transformada produjeron brotes adventicios.

Mora y Lépez (2010) inocularon plantulas de Phaseolus vulgaris con la cepa A.
rhizogenes K599. Estas plantulas inoculadas desarrollaron raices aéreas
transformadas en el sitio de la inoculacion con la bacteria. Las plantas con las
raices transformadas fueron trasplantadas para ser usadas como modelos de

propagacion de Glomus intraradices.
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McAfee y colaboradores (1993) indujeron el enraizamiento in vitro de Pinus
monticola Dougl. usando A. rhizogenes, con lo cual obtuvieron vastagos maduros
con 85% de enraizamiento después de ocho semanas de co-cultivo con A.
rhizogenes cepa A4 mas dosis de ANA 0.3 uM + AIA 1mg/ml

Rodriguez (2002), inoculando el tallo de Agave salmiana Otto., con A. rhizogenes
a una concentraciéon de 1x10° mL™* y 200 pM de acetosiringona, obtuvo un 63 %
de raices transformadas a los 25 dias posteriores a la inoculacién. Esta raices
fueron colonizadas en un 70% por HMA de Glomus intraradices con lo cual se

logré la recuperacion de esporas hijas.

Estada y colaboradores (2006), emplearon A. rhizogenes cepa K599 para
transformar raices de P. vulgaris L., P. coccineus, P. lunatus, y P. acutifolius, con
el fin de establecer programas gendmicos funcionales en la fisiologia de raices,
metabolismo e interacciones microbianas en las mismas. A las tres semanas de
post infeccion con A. rhizogenes se formaron raices robustas y de crecimiento
rapido con una tasa de trasformacién de 75 y 90% ya que todas las especies
formaron raices transformadas. Estas raices fueron inoculadas con Rhizobium
tropici las cuales formaron nodulos de manera normal para fijar nitrégeno

eficientemente.

Felker y colaboradores (2005), realizaron un estudio para mejorar el enraizamiento
de Prosopis alba de 1 a 21 afos de edad y clones de 4 afios, usaron a
Azospirillum brasilense, Pseudomonas aurantiaca y A. rhizogenes cepa Tiger 232
como promotores del enraizamiento en esta especie, siendo A. rhizogenes Tiger
232 quien mostrod los resultados mas consistentes. En adiccion con AIB 9000 mg/l,
ANA 800 mg/l y tiamina HCI a temperaturas de 33°C se obtuvo un porcentaje de
enraizamiento del 80% en P. alba de 21 afios de edad. En contraste, solo se

obtuvo 50% de enraizamiento en los clones de 4 afos de edad.
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Caro y colaboradores (2000), evaluaron la efectividad de la cepa LBA 9402 de A.
rhizogenes en presencia o ausencia de AIB 3 ppm para mejorar el enraizamiento
en segmentos unicodales de Prosopis chilensis de un mes de edad. Sus
resultados muestran que el porcentaje de enraizamiento y el nimero de raices
primarias por explante fue superior en el tratamiento A. rhizogenes + AIB 3ppm,
llegando al 100%. El tratamiento de segmentos inoculados produjo un nimero de
raices por explante significativamente mayor y con un peso seco
significativamente también mayor en comparacion a los segmentos no inoculados
con lo que concluyen que los tratamientos con A. rhizogenes resultaron en una

mejor respuesta al enraizamiento.
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JUSTIFICACION

A pesar de los amplios estudios sobre transformacion de raices con A. rhizogenes
en varias especies de interés comercial como tabaco y zanahoria, poco se sabe
de estudios en especies forestales y silvestres como el mezquite. Las leguminosas
recalcitrantes son notoriamente dificiles para regenerar y transformar por lo que
alun no se ha establecido un protocolo eficiente que permita la transformacién
genética del mezquite. Dada la importancia econdémica, ecoldgica asi como la
problemética ante las dificultades y prolongado tiempo que se requiere para la
propagacion in vitro de P. laevigata, se plantea entonces la opcion de
transformacion de sus raices usando como vector el plasmido Ri de A. rhizogenes,
las cuales serviran posteriormente para el establecimiento de cultivos in vitro de
raices como una alternativa para llevar a cabo diferentes estudios como los
implicados en el proceso de rizogénesis, estudios relacionados con diferentes
tipos de estrés abidtico, produccion de metabolitos secundarios, cultivos
monoxénicos con HMA vy nodulacion con Rhizobium, los cuales proporcionen

informacion para el mantenimiento y fitomejoramiento de esta especie.

Dada esta problematica se plantean la siguiente hipoétesis:

Debido a la patogenicidad de A. rhizogenes, la inoculacion en la zona de infeccion
de la raiz en P. laevigata promovera la incorporacion del plasmido Ri de A.
rhizogenes al genoma del mezquite lo cual incrementara la produccion de auxinas,
opinas Yy citocininas expresando el fenotipo de la enfermedad raices en cabellera

las cuales estaran transformadas y contendran el gen rolB.
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Para realizar esta investigacion se plantearon los siguientes objetivos:

General:
e Estandarizar un método para la transformacion de las raices en mezquite

(Prosopis laevigata) mediante Agrobacterium rhizogenes K599.

Particulares:
e Transformar raices de mezquite mediante A.rhizogenes K599.
¢ Inducir la rizogénisis del mezquite mediante dosis minimas de acido 3-
indolbutirico.
e Comparar la rizogénesis de ambos tratamientos.
¢ Identificar el gen rolB en las raices transformadas.

e Establecer un cultivo in vitro de las raices transformadas.
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MATERIALES Y METODOS

Material Vegetal

Las semillas de P. laevigata utilizadas fueron colectadas en el poblado de San
Martin, en el Valle de Zapotitlan Salinas, Puebla el mes de julio del afio 2008. 100
semillas se desinfectaron colocandolas en benomilo al 50% durante dos dias,
posteriormente se elimind el fungicida con agua destilada estéril para después
sumergirlas en alcohol a 96° durante dos minutos. Hecho esto, las 100 semillas se
escarificaron con &cido sulfrico concentrado (H,SO4) durante 15 minutos,
transcurrido este periodo se neutraliz6 el acido con bicarbonato de sodio. Para
eliminar los residuos se lavaron con agua destilada estéril por una hora y se
colocaron en imbibicién durante 1 dia. Pasado este tiempo, las semillas se
colocaron en cajas Petri con papel filtro estéril y 4 ml de agua para su germinacion
durante 2 semanas en una camara de crecimiento con fotoperiodo de 12 horas luz

y 12 horas oscuridad a una temperatura de 25°C.

Cultivo de A.rhizogenes

Para llevar a cabo la transformacion de las raices se utilizd A. rhizogenes cepa
K599 donada por la Dra. Georgina Hernandez del Centro de Ciencias Gendémicas
de la UNAM. Esta cepa silvestre del tipo cucumopina solo tiene un fragmento del
T-ADN en el plasmido Ri (Combard et al., 1987), es resistente a estreptomicina y
cloranfenicol pero es susceptible a kanamicina y estremtomicina (Taylor et al.,
2006). Debido a su capacidad para inducir eficientemente raices en cabellera en
una amplia variedad de especies, esta sepa se ha convertido en la eleccion de

muchos laboratorios para establecer protocolos eficientes de transformacion.

Para mantener la bacteria activa se resembr6é en medio YEB soélido suplementado
con rifampicina 50 mg L™ a 27°C (Anexo 1). Una vez activa la bacteria se
resembré en medio YEB liquido suplementado con rifampicina 50 mg Lt a 27°C
(Anexo 1) manteniéndose en agitacion constante durante 2 dias hasta obtener una

lectura de densidad Optica a 600 nm.
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Transformacion de raices
Transcurridas las 2 semanas de germinacion del mezquite, las 100 plantulas se
dividieron en 4 lotes con 25 individuos cada uno. Cada lote fue sometido a un
tratamiento con A. rhizogenes con o sin la adicion de AIB 3 ppm quedando de la
siguiente manera: lote A) Control, lote B) A. rhizogenes, lote C) AIB 3 ppm, lote D)
A. rhizogenes + AIB 3 ppm. Bajo condiciones de esterilidad, a todas las plantulas
de cada lote se les corto la raiz lo mas cercano posible al tallo. La adicion exégena
del AIB 3ppm para los lotes C y D fue mediante inmersion de la parte de la herida
(corte de la raiz) en esta solucion durante 1 minuto. La inoculacion de los lotes B
y D con A. rhizogenes se realizd mediante agroinfiltracion, la cual consistio en
tomar con una jeringa de 1 ml medio liquido YEB con la bacteria crecida durante 2
dias para posteriormente infectar en el area donde se produjo la herida en la
plantula de mezquite. Una vez aplicado el tratamiento a cada lote, las plantulas se
trasfirieron a cajas Petri que contenian medio Minimo “M” (Bécard y Fortin, 1988)
(Anexo 2) colocando un maximo de 5 plantulas por caja. Las cajas se mantuvieron
dentro de bolsas negras de plastico para protegerlas de la luz y trasladarlas al

cuarto de crecimiento a una temperatura de 27°C durante 2 dias.

Transcurridos los 2 dias de co-cultivo en medio M, las plantulas fueron
desinfectadas para eliminar por completo a la bacteria y evitar otro tipo de
contaminacion enjuagandolas con agua destilada estéril y una solucién de Tween
80 al 0.1% por 1 minuto, cloro 3% durante 1 minuto y una solucion de rifampicina
50 mg L? hasta que estas fueron trasplantadas a vasos de plastico transparentes
que contenian 10g de agrolita estéril suplementada con 30ml de solucion
Hoagland (Anexo 3). Cada vaso contenia 2 plantulas de mezquite al ser
trasladadas a la camara crecimiento con fotoperiodo de 12 horas luz y 12 horas
oscuridad A 27°C durante 2 meses. Durante este tiempo los mezquites fueron
regados cada semana con solucion nutritiva Hoagland adicionada con Benomilo a
50% (7 g LY.
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Area foliar, longitud de raices, primordios y biomasa
Al finalizar los 2 meses se seleccionaron aleatoriamente 10 mezquites de cada
tratamiento a los cuales se fotografio en un campo estéril la raiz extendida sobre
una escala ajustada a 0.5 cm asi como el area foliar para posteriormente realizar
una medicion de la longitud de cada raiz y un conteo de primordios totales de cada
raiz y el area foliar con el software informatico ImageJ 1.46 (Anexo 4). Una vez
fotografiadas las raices de cada tratamiento, éstas fueron cortadas en el sitio
donde se produjo la herida para la inoculacién y se pesaron para obtener la
biomasa en peso himedo e inmediatamente se trasladaron a un ultracongelador a
-70°C para su conservacion y asi evitar la desnaturalizacion de ADN para la

verificacion de la trasformacién por pruebas de biologia molecular.

Extraccion y amplificacion del ADN

En base en las secuencias de A. rhizogenes del National Center of Biotechnology
Information (NCBI) se disefiaron los oligonucledtidos para los genes rolB
(Referencia NCBI: EF433766.1) (Apéndice 1) y vir D4 (Referencia NCBI:
NC_010841.1) (Apéndice 2), ya que los genes virD de Agrobacterium no se
transfieren al genoma de la planta, este utiliza para descartar la presencia residual
de la bacteria en la raiz (Tabla 1).

. Fragmento
Nombre Secuencia esperado
rolB F 5,GAACTGTGTGATGCCGCAAG 3 ’ 601 pb
R 3'CACGAGATCTCACAAAAGCCTG 5
virD F 5 CAAAGAGCCTTGGAACCGTTTTG 3 486 pb
R 3 CAAATTCGAATGGTTCAGGGAAAC 5

Tabla 1. Secuencia de oligonucleétidos para rolB y virD indicando el
fragmento esperando en pares de bases. Marca Invitrogen Custom Primers

Antes de usar los oligonucledtidos directamente en las muestras de las raices, se
realiz6 una extraccion de ADN de A. rhizogenes crecido en medio YEB liquido

durante 2 dias (Anexo 5) para comprobar que los cebadores amplificaran las
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regiones especfificas esperadas. La temperatura de alineamiento Optima para
ambos oligonucleétidos fue determinada mediante una amplificacion con un

gradiente de temperatura de 55° a 67°C pararolBy 57° a 68°C para virD.

Para comprobar la transformacion de las raices de los lotes B y D fueron
necesarios analisis de biologia molecular con los cuales se buscé un fragmento
del gen rolB en el ADN de la raiz. A partir de 150 mg de raiz macerados en
nitrdgeno liquido de los lotes A, B y D, se llevé a cabo la extraccion del ADN con el
kit ZR Plant/Seed ADN Kit TM siguiendo el protocolo establecido por el proveedor
(Anexo 6). Las muestras de ADN obtenidas fueron mantenidas en un refrigerador

a -20°C para su posterior amplificacion mediante PCR.

Para cada muestra de ADN obtenida de los lotes A, B y D se realizaron reacciones
de PCR para rolB y virD4 en un volumen final de 50ul (25ul de Buffer 2x KAPA
plant + dNTPs 1.5 mM Mg 1x, 1.5ul oligo F, 1.5ul oligo R, 16.6ul de agua
bidestilada desionizada estéril, Taq polimerasa KAPA 3G 0.4ul, muestra de ADN
Sul.

El programa de amplificacion consté de 40 ciclos de 95°C por 10 minutos de
precalentamiento, 94°C por 40 segundos de desnaturalizacion, 67°C (rolB) - 68°C
(virD) por 50 segundos de alineamiento, 72°C por 1:15 minutos de extension, 72°C
por 5 min de extension final y 4°C « en un termociclador SelectCycler. Thermal
Cycler . Los productos de PCR fueron separados por electroforesis a 80 volts
en gel de agarosa al 1% (Anexo 7), tefiido con bromuro de etidio (Img/ml) vy
visualizados en un transiluminador marca Ultra Violet Products White/UV para
posteriormente ser fotografiado en un transiluminador con camara. Todos los
productos de PCR fueron secuenciados en un equipo ABI Prism 3100 de 16
capilares en el laboratorio de Bioquimica Molecular de la UBIPRO en la FES-
Iztacala. UNAM.
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Edicidén, comparaciéon y alineamiento de las secuencias
Con el software Mega v. 5 se obtuvo la secuencia consenso a partir de las
obtenidas por cada muestra, se compararon en el banco de datos del NCBI con la
herramienta online BLAST: Basic Local Alignment Search Tool para un andlisis de
similitud con el cual se obtuvo el nivel de identidad para cada secuencia. Las

secuencias se alinearon con la herramienta online ClustalW.

Analisis estadistico

Para evaluar el efecto de los diferentes tratamientos de A. rhizogenes y AIB en las
raices y conocer las diferencias entre estos, se realizd un andlisis de varianza de
un factor (ANOVA). Posteriormente para identificar los tratamientos entre los
cuales existia diferencia para las medias de cada par posible entre los

tratamientos se realizé una prueba de Tukey.
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RESULTADOS

Analisis morfoldgico, porcentaje de enraizamiento

Transcurridos los 2 meses posteriores a la inoculacion se realiz6 un analisis
morfolégico de 10 raices seleccionadas por cada lote (Figura 3): En el lote A
(Control) solo un 50% de las plantulas formaron raices nuevas y pequefias sin
lignificacion, mientras que el 50% restante solo formé callos en la zona donde se
cortd la raiz. EI 90% de mezquites del lote B (raices con A. rhizogenes) y lote C
(raices con AIB 3 ppm) formaron raices nuevas Yy lignificadas en la zona donde se
realizo la infeccion o donde se agregaron las hormonas. Las raices de ambos lotes
produjeron numerosas ramificaciones a lo largo de la raiz principal. El 100% de las
plantas del lote D (raices con A. rhizogenes + AIB 3 ppm) desarrollaron raices

nuevas lignificadas con numerosas ramificaciones a lo largo de la raiz principal.
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Figura 3. Mezquites tras 2 meses posteriores a la aplicacion del
tratamiento: A) Control, B) A. rhizogenes, C) AIB 3 ppm, D) A. rhizogenes +
AIB 3 ppm.
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Diez plantulas de mezquite de una semana a las que no se le cortd la raiz fueron
inoculadas con A. rhizogenes a lo largo de la misma mediante una jeringa de 1ml.
Transcurridos 2 dias de co-cultivo en medio M, estas fueron desinfectadas y
transferidas a cajas Petri con medio M suplementado con rifampicina 50 mg L-1
para posteriormente trasladarse a un cuarto de crecimiento en total oscuridad a
27°C. Tras una semana en el cuarto de crecimiento las raices se fotografiaron en
el laboratorio de microscopia de la FES-Iztacala. Los resultados mostraron que el
100% de las raices inoculadas con A. rhizogenes desarrollaron pelos radiculares y
primordios a lo largo de sus raices, los cuales no mostraron ningin tipo de
lignificacion mientras que grupo Control no mostré formacion de pelos radiculares

ni primordios a lo largo de la raiz principal (Figura 4).

Figura 4. Formacion de pelos radicales a 4X: Raices de Mezquite
inoculadas con A. rhizogenes en medio M (B), Control en medio M (A).
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Biomasa
Las raices, después de ser fotografiadas y de realizar el analisis morfologico
fueron cortadas para determinar la biomasa. Los resultados de biomasa (peso
himedo) de 10 raices por tratamiento (Grafico 1) revelaron que el lote A, obtuvo
un resultado esperado ya que al no ser tratado con la bacteria ni suplementado
con hormonas presento un crecimiento minimo de raices con 0.1444 g totales,
seguido por el lote B que produjo 273% y el lote C con 353% mas biomasa con
respecto al lote A. EIl tratamiento que mayor biomasa produjo fue la combinacion
de A. rhizogenes + AIB 3 ppm perteneciente al lote D, el cual cuadruplicé la

cantidad obteniendo un 427% mas biomasa.
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Grafico 1. Porcentaje de biomasa peso humedo: A. rhizogenes (Ar), Acido
3-Indol butirico 3ppm (AB), A. rhizogenes + Acido 3-Indol butirico 3ppm
(Ar+AIB). Control.
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Longitud de raices
El analisis de ANOVA de un factor demostré que entre los tratamientos existieron
diferencias tanto para los parametros de longitud, nUmero de brotes y &rea foliar.
Los datos de longitud de las raices fueron analizados con la prueba de
comparacion de medias Tukey con una significancia de 0.95 (Apéndice 3) el cual
determind los grupos entre los cuales existid diferencia. La mayor diferencia
significativa se presentd en el lote D, donde las plantulas desarrollaron 287%
raices mas largas que el lote A, mientras que los lotes C con 245% y B con 219%,
estadisticamente no mostraron diferencias significativas entre si (Grafico 2). El

mismo comportamiento fue observado para la biomasa.

25
20
_[ c *%
*

15 'I'* b
- b
E |
L
© 10
>
=
(@]
g a
4 > ]

0 - T T 1

Control Ar AIB Ar+AlB

Grafico 2. Longitud: +/- E.E: A. rhizogenes (Ar), Acido 3-Indol butirico 3ppm
(AIB), A. rhizogenes + Acido 3-Indol butirico 3ppm (Ar+AIB), Control.
E.E: Error estandar, * :Nivel de significancia
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Numero de primordios
La cantidad de primordios o brotes en las raices del lote D fue significativamente
mayor (de acuerdo a la comparacion de medias Tukey con una significancia de
0.95 (Apéndice 4), con un 475% mas primordios respecto al lote A. El lote B con
un 300% de brotes y lote C con 287.5% no mostraron diferencias significativas
entre sipero a pesar de esto, el lote B tuvo mayor de primordios que el lote tratado
con AIB 3 ppm, Este parametro fue el Unico en donde el tratamiento de A.

rhizogenes promovié mejores resultados que el AIB 3 ppm (Grafico 3).

14
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10

Control Ar AIB Ar+AlB

Grafico 3. Numero de brotes: +/- E.E: A. rhizogenes (Ar) 7.2, Acido 3-Indol
butirico 3ppm (AIB) 6.9, A. rhizogenes + Acido 3-Indol butirico 3ppm (Ar+AIB)
11.4, Control 2.4. E.E: Error estandar, * :Nivel de significancia
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Area foliar
El area foliar fue el parametro donde la mayor diferencia significativa corresponde
al lote C (Apéndice 5). Para este parametro sin importar la ausencia de raices en
el lote A, el 100% de los mezquites desarrollaron un area foliar minima. El lote C
presentd la mayor area foliar de todos los tratamientos con 188% mas con
respecto al Control, a pesar de no ser el que mostro la longitud de raices superior,
ni presentar el mayor nimero de brotes en la raiz. El lote D (area foliar de 153%)
que habia mostrado mayores diferencias significativas en biomasa, longitud y

nimero de brotes, no mostré6 ser diferente respecto al lote B tratado con A.

'
1

Ar+AlB

rhizogenes con un area foliar de 143% (Grafico 4.).
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Grafico 4. Area foliar: +/- E.E: A. rhizogenes (Ar) 3.58 cm, Acido 3-Indol

butirico 3ppm (AB) 4.73cm, A. rhizogenes + Acido 3-Indol butirico 3ppm
(Ar+AIB) 3.84 cm, Control 2.51 cm.
E.E: Error estandar, * :Nivel de significancia
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Verificacion de la trasformacién por pruebas de biologia molecular
El gradiente de temperatura de alineamiento 6ptima para ambos oligonucleotidos

se determin6 mediante un gel de agarosa, donde se observd que la temperatura

de alineamiento 6ptima para rolB fue de 67°C y para virD 68°C (Figura 5y 6).
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Figura 5. Productos de la amplificacion para rolB mediante el gradiente de
temperatura donde 67°C fue 6ptima.
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Figura 6. Productos de la amplificacion para virD mediante el gradiente de
temperatura donde 68°C fue 6ptima.
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De las raices obtenidas de cada tratamiento, se realizd la extraccion y
amplificacion de ADN para buscar el fragmento del gen rolB el cual es transferido
a la raiz. Debido al que el gen virD solo esta involucrado en la virulencia de
Agroacterium hacia el hospedero, éste no se transfiere al genoma de la planta por
lo que sirvi6 para descartar la contaminacion residual por la bacteria en las raices.
Los resultados mostraron que no existié contaminacion residual por la bacteria tras
la desinfeccion de las raices en los lotes A, B y D a los cuales se les realizé la
extraccion y amplificacion de ADN ya que al usar los oligonucleétidos disefiados
en ningun caso se amplifico el fragmento esperado para virD (Figura 7). Sin
embargo, de manera imprevista y a pesar de descartar la contaminacién residual
en el lote Control, se obtuvo un fragmento el cual solo era esperado para el gen
rolB que indica la incorporacion de plasmido Ri al genoma del hospedero y con

éste, la transformacion exitosa de las raices (Figura 8).
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Figura 7. Amplificacion del gen virD en raices definfectadas: A. rhizogenes
(Ar), A. rhizogenes + AIB 3ppm (Ar+AIB). Control (Ctrl).
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Figura 8. Amplificacion del gen rolB en raices: A. rhizogenes (Ar), A.
rhizogenes + AIB 3ppm (Ar+AIB). Control (Ctrl). Se encontré un fragmento
correspondiente al gen en todos los lotes. Concentracion relativa de ADN Ar:
6565.598, Ar+AIB: 1789.941, Ctrl: 1398.577.

Las secuencias de los fragmentos mostrados en el gel correspondiente a los lotes
A y B se compararon con los depositados en las bases de datos para comprobar
gue estos correspondieran con el gen rolB de A. rhizogenes. Para ellos las
secuencias obtenidas con los oligonucleodtidos Forward
5 GAACTGTGTGATGCCGCAAG 3 y Reverse 3
CACGAGATCTCACAAAAGCCTG 5° fueron alineadas y se obtuvo la secuencia
consenso para ambas muestras. Asi, se obtuvieron dos secuencias, la primera
con 521 pb para el Control (Figura 9) y la segunda con 570 pb para las raices
tratadas con Agrobacterium (Figura 10). Con la herramienta online ClustalW 2.1 a
éstas se les realizd un alineamiento muditiple para determinar su identidad con
respecto al fragmento del gen rolB a partir del cual se disefiaron los
oligonucleétidos. El analisis mostro una fuerte similitud entre las secuencias
analizadas. So6lo en la secuencia del lote Control, se encontraron dos diferencias
en las bases (A por G y A por C) respecto a las secuencias de lote B y la original
de rolB (Figura 11).
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GGAGCGGTTTCCAATGCCTTGCCGCACGAAGAAGGTGCAGGCTACCTCCCTGACGTACACA
TTTGTCACTTTTAACTCCAGCAGGTGAATGAACAAGGTACTTGCAAAAATGGCGATAAAAC
CTTCCAGATCAGGTTCTTCCACGCGGCGGTGCGGCCAAGCAATGTTGTGAGCACGGACCAT
CTCCTGGAGGGCGAGGTCGCTACGATAGGGTTGCATCGTGGTCGCCAGCACGGCCTCTAAT
CCAAACGTGATGGATTTTTCCTCCAGTACTTTCTGCATCTTCTCGCGAGATAGATAGACAA
ATACATGTCGGTCGTTTTCTCTGGCCAAATCCGGTTGATCGACAAGCATGGGGGGATGATA
ACATACTTTGTTTTTTAGAAGATGGGCCAGTTGTTTAAGTATGACCACCGGCGGACGGTTT
TCCTCCAAATCAAGCACGCCTTGGGCCCACCTTTTCTGGAAATCCATGAGAGTTTTGCTAT
AGACTTGGCTATAGATTAAAAATGCAAATTGGA

Figura 9. Secuencia consenso obtenidas de las raices del lote A, Control.
521 pb.

CCGCAAGCAATGACGTCATAGGAGCGGTTTCCAGTGCCTTGCCGCACGAAGAAGGTGCAGG
CTACCTCCCTGCCGTACACATTTGTCACTTTTAACTCCAGCAGGTGAATGAACAAGGTACT
TGCAAAAATGGCGATAAAACCTTCCAGATCAGGTTCTTCCACGCGGCGGTGCGGCCAAGCA
ATGTTGTGAGCACGGACCATCTCCTGGAGGGCGAGGTCGCTACGATAGGGTTGCATCGTGG
TCGCCAGCACGGCCTCTAATCCAAACGTGATGGATTTTTCCTCCAGTACTTTCTGCATCTT
CTCGCGAGATAGATAGACAAATACATGTCGGTCGTTTTCTCTGGCCAAATCCGGTTGATCG
ACAAGCATGGGGGGATGATAACATACTTTGTTTTTTAGAAGATGGGCCAGTTGTTTAAGTA
TGACCACCGGCGGACGGTTTTCCTCCAAATCAAGCACGCCTTGGGCCCACCTTTTCTGGAA
ATCCATGAGAGTTTTGCTATAGACTTGGCTATAGATTAAAAATGCAAATTGGATCTCATTG
AACAAGTTAAGCTGGTTCCAG

Figura 10 Secuencia consenso obtenidas de las raices del lote B, tratadas
con A. rhizogenes. 570 pb.
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Figura 11. Alineamiento mdultiple de secuencias con ClustalW: Se
comparan las secuencias consenso de los lotes Ay B contra la secuencia

original de rolB.
* Areas de las secuencias idénticas,

similares.

:: Areas de las secuencias fuertemente
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Al comprar las secuencias del lote Control y B con las depositadas en el NCBI
mediante la herramienta BLAST, la busqueda arroj6 5 secuencias idénticas en
ambos casos pero con diferentes niveles de identidad. En todos los casos el valor
de E fue de 0.0 lo cual representa una fuerte identidad entre las secuencias. La
secuencia del lote B mostré un resultado esperado con una identidad méxima de
100% con la secuencia A. rhizogenes plasmid Ri T-ADN region (Referencia NCBI:
EF433766.1) y una identidad minima de 98% con A. rhizogenes genes rolA, rolB,
rolC, rolD (Referencia NCBI: X64255.1) (Tabla 2).

Max  Total Query E Max
score score cover value ident

1053 1053 100% 0.0 100% EF433766.1

Raiz A. rhizogenes Accession

Agrobacterium rhizogenes plasmid Ri T-ADN
region

Agrobacterium rhizogenes plasmid pRi2659 T-
ADN sequence, ORF2,0ORF3, ORF4, ORF8, 1042 1042 100% 0.0 99% AJ271050.1
ORF10, ORF11, ORF12, ORF13, ORF13a,

ORF14 and cus gene

A-rhizogenes (NCPPB2659) ADN from central 1042 1042 100% 0.0 99%  Z29365.1
region of the cucumopine T-ADN

Agrobacterium rhizogenes plasmid pRi1724 ADN, 981 981 100% 0.0 98%  AP002086.1
complete sequence

Aarobacterium rhizoaenes plasmid pRi1724 rolA, 981 981 100% 0.0 98%  AB006689.1
rolB, rolC gene, partial and complete cds

0, 0,
Arhizogenes genes rolA, rolB, rolC, rolD 976 976 100% 00 98%  X64255.1

Tabla 2. Resultados del analisis BLAST: Muestra las secuencias con mayor
identidad para la secuencia de las raices tratadas con A. rhizogenes.

La secuencia del lote Control, corresponde a un fragmento especifico del plasmido
Ri con una identidad maxima del 99% con A. rhizogenes plasmid Ri T-ADN region
(Referencia NCBI: EF433766.1) y con A. rhizogenes genes rolA, rolB, rolC, rolD
con una identidad de 98% (Referencia NCBI: X64255.1) (Tabla 3).
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http://www.ncbi.nlm.nih.gov/nucleotide/151427929?report=genbank&log$=nucltop&blast_rank=1&RID=F0FKD9K0015
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_6706117
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_6706117
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http://www.ncbi.nlm.nih.gov/nucleotide/6706117?report=genbank&log$=nucltop&blast_rank=2&RID=F0FKD9K0015
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_599608
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_599608
http://www.ncbi.nlm.nih.gov/nucleotide/599608?report=genbank&log$=nucltop&blast_rank=3&RID=F0FKD9K0015
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_10567310
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_10567310
http://www.ncbi.nlm.nih.gov/nucleotide/10567310?report=genbank&log$=nucltop&blast_rank=4&RID=F0FKD9K0015
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_2440224
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_2440224
http://www.ncbi.nlm.nih.gov/nucleotide/2440224?report=genbank&log$=nucltop&blast_rank=5&RID=F0FKD9K0015
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_468518
http://www.ncbi.nlm.nih.gov/nucleotide/468518?report=genbank&log$=nucltop&blast_rank=6&RID=F0FKD9K0015
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Max  Total Query E Max
score score cover value ident

952 952 100% 0.0 99% EF433766.1

Raiz control Accession

Agrobacterium rhizogenes plasmid Ri T-ADN
region

Agrobacterium rhizogenes plasmid pRi2659 T-
ADN sequence, ORF2,0RF3, ORF4, ORF8, 941 941 100% 0.0 99% AJ271050.1
ORF10, ORF11, ORF12, ORF13, ORF13a,

ORF14 and cus gene

A-rhizogenes (NCPPB2659) ADN from central 941 941 100% 0.0 99%  Z29365.1
region of the cucumopine T-ADN

Agrobacterium rhizogenes plasmid pRi1724 ADN, 885 885 100% 0.0 98%  AP002086.1
complete sequence

Agrobacterium rhizogenes plasmid pRi1724 rolA, 885 885 100% 0.0 98% AB006689.1
rolB, rolC gene, partial and complete cds

0, 0,
Arhizogenes genes rolA, rolB, rolC, rolD 880 880 100% 00 98%  X64255.1

Tabla3. Resultados del analisis BLAST: Muestra las secuencias con
mayor identidad para la secuencia de las raices Control.

Con el fin de determinar la similitud entre los productos codificados por las
secuencias del lote Control y el lote B con las depositadas en el banco de datos
del NCBI, se tradujeron a proteinas con la herramienta SIXFRAME de Biology
WorkBench 3.2 en donde para ambas muestras se obtuvo una secuencia idéntica
de 168 amino acidos. Obtenidos los producto (Figura 12), la mismas se usaron
para realizar una busqueda de proteinas homologas (BLASTp). Para ambos casos
se observo una similitud con 36 secuencias depositadas en la base, de las cuales
solo 7 superaron el 80% de identidad maxima (Tabla 4) y con valores para E
cercanos a 0. La unica secuencia con un 100% de identidad maxima correspondio
a hypothetical protein [A. rhizogenes] (Referencia NCBI: ABS11824.1). Ademas,
también se obtuvo una identidad del 83% con protein tyrosine phosphatase
[Catharanthus roseus] >gb|ABI54190.1| tyrosine phosphatase RolB [Catharanthus
roseus] (Referencia NCBI: ABI54184.1).

MDFOQKRWAQGVLDLEENRPPVVILKQLAHLLKNKVCYHPPMLVDQPDLARENDRHVEVYLS
REKMOQKVLEEKSITFGLEAVILATTMQPYRSDLALQEMVRAHNTIAWPHRRVEEPDLEGEFIAT
FASTLFIHLLELKVTNVYGREVACTFFVROGTGNR

Figura 12. Traduccién a proteinas: Marco abierto de lectura para las
secuencias Control y lote B
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http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_10567310
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http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_2440224
http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_2440224
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http://blast.ncbi.nlm.nih.gov/Blast.cgi#alnHdr_468518
http://www.ncbi.nlm.nih.gov/nucleotide/468518?report=genbank&log$=nucltop&blast_rank=6&RID=F0FKD9K0015
http://www.ncbi.nlm.nih.gov/protein/151427935?report=genbank&log$=prottop&blast_rank=1&RID=GEZ9W2XS015
http://www.ncbi.nlm.nih.gov/protein/151427935?report=genbank&log$=prottop&blast_rank=1&RID=GEZ9W2XS015
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Max Total Query E Max

Proteinas secuencia Control . Accession
score score cover value ident

hypothetical protein [Agrobacterium rhizogenes] 331 331 100% 2f102E- 100% ABS11824.1
RecName: FuII:Prc_)tein-tyrosine phosphatase RolB;
Short=ROL_B prot_eln >emb|CAA45540.1|rolB 395 325 100% 3.00E- 98% P49409.1
[Agrobacterium rhizogenes] 110
hypothetical protein pRi1724_p016 [Agrobacterium
rhizogenes]>dbj|BAA22335.1| hydrolyze
phytohormone glucoside [Agrobacterium rhizogenes] o. S8.00E- o
>dbj|BAB16134.1| riorf15 [Agrobacterium 325 325 100% y,, 98% NP_066596.1
rhizogenes]>prf||[2009229C rolB gene
ORF11 [Agrobacterium rhizogenes]
>emb|CAB65895.1| hypotethical protein, 4.00E-
homologous to ORF11 of pRiA4 [Agrobacterium 302 302 100% '101 93% CAA82552.1
rhizogenes]
protein tyrosine phosphatase [Catharanthus roseus]
>gb|ABI54190.1| tyrosine phosphatase RolB 280 280  99% 8.00E- 83% ABI54184.1
[Catharanthus roseus] 93
RolB, partial [Agrobacterium rhizogenes] 280 280  99% Q.SgE- 83% ACHS81986.1
RecName: Full=Protein-tyrosine phosphatase RolB;
Short=ROL B protein >emb|CAA27163.1| unnamed
protein product[Agrobacterium rhizogenes] o 2.00E- o
>gb|ABR18542.1| hypothetical protein [Catharanthus 219 279 99% 92 83% P20402.1

roseus]

Tabla 4. Resultados del andlisis BLAST para proteinas: Muestra las
secuencias con mayor identidad para la muestra de las raices Control.

Con la finalidad de descartar la posibilidad de que las raices del grupo Control se
hubieren contaminado con la bacteria, se obtuvieron raices de mezquite de 6
meses de edad donadas por la Biol. Marta Santiago, las cuales se encontraban en
un sustrato de arena estéril y raices de frijol de 10 dias sin ningun tratamiento. A
ambas se les extrajo su ADN y se someti6 a amplificacion por PCR con los
oligonucleétidos de rolB (Figura 13). Se revelo la amplificacion de un fragmento
con el peso esperado para este gen en ambas raices. Sin embargo, en las
muestras de frijol a pesar de obtener una banda con el peso esperado para rolB
(600 pb aproximadamente), se reveld otro fragmento no secuenciado de
aproximadamente 800 pb lo cual podria indicar que el oligonucle6tido pudo

amplificar otras regiones no pertenecientes a rolB.
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Figura 13. Amplificacion del gen rolB en raices de mezquite y frijol: Se
observa un fragmento correspondiente al gen en ambas raices.
Concentracion relativa de ADN mezquite: 6159.861, frijol: 1035.012.
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DISCUSION

AlB

La aplicaciéon exdgena de auxinas ha demostrado inducir exitosamente la
formacion de raices adventicias en tallos, esquejes y explantes del género
Prosopis ya que varias especies muestran una buena capacidad en enraizamiento
con éstas, principalmente AIB. Prosopis juliflora ha alcanzado tasas de hasta 90%
de enraizamiento y Prosopis glandulosa hasta un 100%. Sin embargo, estas usan
grandes cantidades de hormonas como se ve en los resultados obtenidos por
Felker (1998), adicionando dosis de 6000 a 9000 ppm de AIB sobre varetas del
crecimiento terminal de ramas han dado resultados satisfactorios con un 50 a
100% de enraizamiento en diversas especies de mezquite. Por otro lado
Oberschelp y Marc6 (2010), en estacas herbaceas de P. alba de 6 afios de edad
con dosis de 5 ppm de AIB se obtuvo un porcentaje del 45% a los 2 meses de

tratamiento.

Para P. laevigata, se han obtenido resultados exitosos a dosis menores de AlB,
como las repostadas por Olvera (2006), que en esquejes suplementados con AIB
a dosis 100 ppm obtuvo un 80% de enraizamiento. No obstante, los resultados
obtenidos con dosis minimas de AIB 3 ppm en plantas de 2 meses de edad sin
raiz en éste trabajo, indican que existen diferencias con los estudios antes
mencionados ya que a ésta dosis obtuvo un 90% de enraizamiento. Esto puede
deberse a la edad y estado en el que se encontraban los mezquites, ya que al
contar aun con las hojas jévenes y yemas, las cuales son la principal fuente de
auxinas enddgenas que son transportadas a la zona de enraizamiento, permiten la
rizogénesis en ausencia de hormonas exdgenas (Hartmann et al., 1997). A su
vez, las hojas permiten la produccion de carbohidratos derivados de la
fotosintesis, los cuales funcionan como fuente de energia para el proceso
rizogénico (Gutierrez, 1997). Al interactuar las auxinas secretadas por las raices
transformadas con secciones de las raices no transformadas, éste efecto se

puedo ver potencializado ya que aun a muy bajas concentraciones promueven el
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desarrollo de raices laterales asi como participar en las respuestas de crecimiento

de tallo y raiz al estimulo de luz y gravedad (Martinez, 2004).

Contrario a lo esperado, éste tratamiento de hormonas exdgenas fue el que
obtuvo mayores diferencias significativas para los resultados de area foliar ya que
desarroll6 un 188% mas area foliar que el control. Este patron de respuesta ha
sido encontrado en gran cantidad de otras especies, donde normalmente se da un
aumento en la capacidad de enraizamiento al aumentar la dosis de auxina hasta
alcanzar un 6ptimo. Como se ha indicado, los efectos positivos de las auxinas en
el enraizamiento han sido asociados a sus efectos sobre la division celular, el
aumento de transporte de carbohidratos y otros cofactores que pueden mejorar el

desarrollo foliar (Ruiz y Mesén, 2010).

El nivel endégeno de auxinas es uno de los principales factores que mas se ha
relacionado con la capacidad rizogénica. Se ha atribuido un papel especialmente
importante en éste proceso de controlar las peroxidasas, las cuales son enzimas
cuya funcién primaria es oxidar moléculas a expensas de peroxido de hidrégeno
(Olvera, 2006). Existen varias isoenzimas de la AlAoxidasa, sin embargo las
auxinas sintéticas como es el caso del AIB no son destruidas por éstas oxidasas,
por lo que persisten en la planta mucho mas tiempo que el AIA (Salisbury, 1994).
Por tanto se puede atribuir que este efecto en la produccion de raices adventicias
por AIB, se debe a que la enzima AlAoxidasa presenta menos afinidad por esta
hormona y por lo tanto ésta permanece mas tiempo en la planta (Quintanar, 2006)

y asi potencia su accién rizogénica.

Las auxinas rapidamente ocasionan la acumulacion transitoria de tres familias de
genes: SAURs, genes tipo GH3 y Aux/IAA (Abel y Theologis, 1996). Aunque se
desconoce la funcidén exacta de estos genes, varios de ellos estan involucrados en
la conjugacion y degradacién de auxinas y en mermar la sefial por la hormona.
Las proteinas AUX/IAA forman dimeros con los factores de transcripcion ARF
(Auxin Response Factors) inhibiendo la union a elementos de promotor que

responden a auxinas (Liscum y Reed 2002). Una vez degradados AUXI/IAA, los
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factores ARFs pueden formar homodimeros e inducir la expresion de varios genes
blanco y desatar distintas respuestas fisiologicas comunmente medidas como

respuestas de crecimiento (Li etal., 1991).

El efecto del mayor porcentaje de enraizamiento del AIB esta en funcion a la
mayor estabilidad de esta hormona en el interior de las plantas que el AIA y a su
posterior conversion en AlA a través de la B-oxidacion (Olvera, 2006). Lo ocurrido
en el grupo control que solo contaba con la produccion de AIA enddgenas, solo el
50% de mezquites formaron raices nuevas y no se desarrollaron completamente,
ademas de no producir una area foliar, brotes, biomasa asi como una longitud de
raices en cantidad significativa, cabria sugerir que ésta respuesta podria ser

dependiente de la adicion de hormonas exdgenas (Trejo, 2007).

A.rhizogenes

En base a los resultados obtenidos en el presente trabajo de investigacion, se
demostrd6 que P. laevigata fue susceptible a la infeccién con A. rhizogenes al
lograr inducir el enraizamiento. Una de las principales diferencias se observé en el
nimero de brotes con el tratamiento de A. rhizogenes ya que este desarrollé una
mayor cantidad de brotes que el sometido a AIB 3 ppm. Estos mezquites al ser
inoculados aun siendo plantulas, sus células se encentran en etapa embrionaria y
con una mayor division celular ademas de presentar una gran cantidad de células
indeterminadas, las cuales son mas susceptibles a la integracién del T-ADN y
expresion del plasmido Ri (Aird et al., 1988). Aunado a esto, el corte realizado en
el tejido vegetal estimula la produccién de algunos compuestos fendlicos como la
acetosiringona que atrae por quimiotaxis a Agrobacterium para proveerle acceso a
los sitios de reconocimiento sobre la superficie celular (Rodriguez, 2002). En este
sentido podria sugerirse que incrementando el tiempo dentro la camara de
crecimiento, asi como el tiempo de co-cultivo, cada brote en la raiz formara raices
verdaderas con el gen rolB incorporado lo cual incrementara la produccion de
auxinas, que a Ssu vez, promoveran nuevos brotes en estas raices y asi

incrementar la longitud y biomasa para este tratamiento.
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A.rhizogenes + AIB
En este estudio, el tratamiento de A. rhizogenes suplementado con AIB 3 ppm en
general reforzd el efecto positivo de esta interaccion ya que siempre presentd una
mayor efectividad y diferencia significativa en porcentaje de enraizamiento,

biomasa, longitud asi como el nimero de brotes comparado con a los otros

tratamientos.

Estos resultados no difieren de los reportados por Caro (2000), en donde
segmentos unicodales de plantulas de 1 mes de edad de P. chilensis en medio MB
suplementado con A. rhizogenes LBA 9402 en combinacion con AIB 3 ppm
muestran mejor respuesta al enraizamiento y biomasa con este tratamiento. En
especies como pino (Li y Leung, 2003), también se ha observado este patron,
donde al inocular material vegetal con A. rhizogenes y cultivar en un medio
suplementado con AIB, no sélo el porcentaje de enraizamiento aumenta sino que
también el nimero de raices. En este sentido Ercan et al., (1999) reporta que los
sintomas producidos por esta bacteria son debido al aumento de la sensibilidad de
las células vegetales al efecto de las auxinas exdgenas, mas que a la produccion

de hormonas enddgenas por la propia planta.

A pesar de las altas tasas de enraizamiento, biomasa Yy longitud reportadas tanto
en este trabajo y por Caro (2000), no se encontraron diferencias significativas
entre los tratamientos que utilizaron en forma separada la induccion mediada por
A. rhizogenes o por auxina. La elecciéon de una u otra via rizogénica, en ultima
instancia, dependera del comportamiento de las microplantas en campo, como por
ejemplo una mayor supervivencia y crecimiento o de acuerdo a los fines que se

persigan.

Factores que influyen en el enraizamiento

La temperatura 6ptima de enraizamiento reportada para mezquite es de 35°C asi
como un fotoperiodo de 12 horas, mientras que la temperatura Optima para la
infeccién con A. rhizogenes es de 23°C, esta discrepancia en las temperaturas

optimas es una desventaja en el enraizamiento de Prosopis. Sin embargo, en este
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trabajo, la temperatura a la cual se mantuvo la camara de crecimiento no parecio
influir de manera perjudicial en el enraizamiento de P. laevigata inoculado con la
bacteria + AIB 3ppm, ya que éste se encontraba muy por debajo (27°C) de las
reportadas como Optimas para mezquite. Felker (2005), encontr6 que la
temperatura de 33°C influyd de manera positiva en explantes de P. alba
inoculados con A. rhizogenes Tiger 232 mas AIB 9000 mg/l, ANA 800 mg/l y
tiamina HCl ya que se obtuvo un porcentaje de enraizamiento del 80% en

explantes obtenidos de plantas de 21 afios.

Factores como el medio o sustrato donde las raices se desarrollan, juegan un
papel importante en el crecimiento de éstas. Se observaron diferencias tanto en el
medio M, donde las plantulas de una semana inoculadas con la bacteria formaron
el fenotipo caracteristico de las raices en cabellera ya que medios con alta
concentracion salina como el Murashige & Skoog (MS), favorecen la formacion de
raices en cabellera en algunas plantas mientras que medios de baja concentracion
osmoética tal como BTM incrementan la proliferacion bacteriana (Caro, 2000). Sin
embargo, el sustrato agrolita suplementada con solucién Hoagland favorecié el

desarrollo de raices verdaderas y lignificadas con gran cantidad de primordios.

Analisis moleculares
Los resultados morfolégicos demostraron el efecto positivo que Agrobacterium

produjo en mezquite, asi como los resultados obtenidos en el gel de agarosa, la
secuencia de 570pb y su andlisis BLAST que arrojo una identidad maxima con el
plasmido Ri de A. rhizogenes (Referencia NCBI: EF433766.1), comprobaron la
transformacion de las raices que fueron tratadas con la bacteria ya que este
sistema permitié la posibilidad de introducir el gen de interés rolB que incremento
la respuesta a reguladores del crecimiento por parte de los tejidos transformados
al sistema radical de P. laevigata el cual fue el responsable del desarrollo del
mismo sin afectar con ello a la parte aérea, pigmentacion, hojas en forma desigual,
reducida dominancia apical o pérdida de geotropismo, conservando sus

caracteristicas forestales deseadas.
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Debido a que A. rhizogenes, para estimular el enraizamiento involucra
controversialmente el hecho de transferir su ADN a la planta, estos organismos se
consideran genéricamente modificados. Se sabe que A. rhizogenes puede
estimular el enraizamiento de varias especies recalcitrantes sin necesariamente
estar transformadas, sin embargo dado a que esta infecciébn puede ocurrir de
forma natural las plantas infectadas no deberian considerarse transgénicas. El
anico problema que existe con esta bacteria es la posibilidad de expandirla como

patdgeno dentro de un nuevo ambiente (Felker, 2005).

Ante los resultados obtenidos mediante secuencia del grupo control de 521 pb
(Figura 9) que al realizar un analisis Blast correspondié a una region del plasmido
de A. rhizogenes (Referencia NCBIl: EF433766.1), se podria sugerir algun tipo de
contaminacion externa y a pesar de que éste lote siempre se mantuvo en
condiciones asépticas se desinfectd previamente a la extraccién del ADN. La
contaminacion residual por la bacteria se descartd mediante la amplificacién del
gen virD, el cual no se transfiere al genoma de la planta se utiliza para descartar la
presencia de la bacteria en la raiz. No obstante, el hecho de que se presenté una
secuencia homologa al gen rolB de Agrobacterium rhizogenes dentro de las
plantas Control, no implica que éstas se encuentren transformadas debido a que
no expresaron ningun fenotipo caracteristico de las raices en cabellera ya que
podrian carecer de los mecanismos de activacion de produccion no solo de

auxinas sino también de citocininas u opinas.

Como se ha mencionado anteriormente, la region T-ADN_ porta aproximadamente
18 potenciales genes, de los cuales rolA,B, C y D tienen un papel importante en la
induccion de las raices en cabellera, aunque nada se sabe acerca de las proteinas
codificadas por estos genes. La region T-ADNg porta genes responsables de la
sintesis de opinas y dos genes para la biosintesis de las auxinas referidos como
auxl y aux2 los cuales se encuentran de manera natural en las plantas, asi como
genes homologos a rolB pero la funcion de estos genes aun son desconocidas.
Se han realizado diversos experimentos para demostrar que los genes aux no

juegan un papel importante en la formacion de raices en cabellera como lo hacen
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los genes rol, sin embargo se han reportado estudios en donde los genes aux son

indispensables en la formacién de raices en cabellera (Nemoto et al., 2009).

A pesar de que la secuencia de rolB se presentd en las plantas Control, en la
literatura no se ha encontrado reporte alguno sobre la presencia de A. rhizogenes

en regiones de Puebla, sin embargo se sabe que el mezquite sufre la incidencia
de Agrobacterium tumefaciens (CONAZA, 1994). En plantaciones de durazno,

dentro del estado de México se ha identificado A. tumefaciens (Gonzales et al.,
2005). Tanto A. tumefaciens como A. rhizogenes infectan a mas de 600 especies
ubicadas dentro de 90 familias de dicotiledoneas que van desde frutales,
ornamentales y forestales. Ademas contienen un plasmido de entre 200 y 800 kb
denominado plasmido Ti (tumor inducing) o Ri los cuales son genéticamente
similares al compartir genes homélogos en el T-ADN (Gelvin, 2010). Cabe
destacar que no existieron diferencias entre las secuencias de las raices tratadas
con A. rhizogenes y la original de rolB extraida del banco de datos, sin embargo la
secuencia del grupo control fue la Unica que mostré6 dos cambios de pares de
bases a lo largo de la misma lo cual indicaria que una vez que fue recombinada la
secuencia, ésta ha sufrido sustituciones. Con el fin evidenciar la eliminacion total
de las bacterias mediante la desinfeccion de las raices inoculadas o asi como
presencia de Agrobacterium en el area de estudio se sugiere realizar pruebas
como las reportadas por Alippi (2011), que desarrollaron técnicas precisas que
permiten detectar la presencia de especies de Agrobacterium a partir de muestras
de material vegetal o suelo que mediante PCR’s especificos sobre los genes virC1
y virC2 asi como bioensayos en plantulas se reduce la posibilidad de obtener

falsos negativos y/o falsos positivos.

Una de las grandes ventajas que se aprecian a través de la generacion de raices
por A. rhizogenes es la ausencia de la fase de formacion de callos que provoca
variacion somaclonal. La presencia de raices en cabellera en P. laevigata
posibilitaria ademas la obtencion de individuos con mejor desempefio de
implantacion y un camino posible para el mejoramiento de la especie a través de

la transformacion de las raices mediante esta bacteria. La incapacidad para inducir
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la formacion de raices adventicias es a menudo, factor limitante en el cultivo de
tejidos de especies recalcitrantes en las que la maduracion frecuentemente va
acompafnada de una reducida capacidad de enraizamiento. En algunas especies,
la habilidad para formar raices esta ausente en la fase de maduracion, esto ha
afectado grandemente la explotacion genética de plantas lefiosas horticolas,
forestales y silvestres (Haissig, 1992). Por otro lado, se menciona que las especies
lefliosas son muy dificiles de clonar in vitro, debido a que su capacidad de
regeneracion es débil, presentan dormancia, entre otras caracteristicas que

dificultan su propagacion (Pierik, 1990).

Es bien sabido que los programas clasicos de mejoramiento genético de especies
forestales son lentos y tediosos, resultando sumamente dificil introducir genes de
interés especificos a traves de ciclos de cruzamiento de lineas parentales. Sin
embargo, como se observd en los resultados obtenidos en este trabajo, A.
rhizogenes mostrd, como alternativa a los tratamientos de grandes cantidades de
hormonas exdgenas, ser un factor importante en la rizogénesis de mezquite. Las
raices transformadas obtenidas de éste arbol posibilitarian posteriormente el
establecimiento de cultivos in vitro de raices como una alternativa para llevar a
cabo diferentes estudios como los implicados en el proceso de rizogénesis,
estudios relacionados con diferentes tipos de estrés abibtico, produccién de
metabolitos secundarios, cultivos monoxénicos con HMA y nodulacion con
Rhizobium, los cuales proporcionen informacion para el mantenimiento y

fitomejoramiento de esta especie.
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CONCLUSIONES

El tratamiento con AIB 3 ppm mostré un efecto positivo en el enraizamiento y area
foliar del mezquite ya que con éste tratamiento se duplicé el area foliar respecto al
control. Se determind que P. laevigata es susceptible a la infeccion con A.
rhizogenes al lograr inducir el enraizamiento y una mayor cantidad de brotes que
los lotes sometidos a AIB 3 ppm. A pesar de las altas tasas de enraizamiento,
biomasa y longitud, no se encontraron diferencias significativas entre los
tratamientos que usan de forma separada A. rhizogenes o AIB. Las plantulas
sometidas a A. rhizogenes + AIB 3 ppm en general mostraron sinergia. Este
tratamiento presentd una mayor efectividad y diferencia significativa en cuanto al
porcentaje de enraizamiento, biomasa, longitud asi como el nUmero de brotes

comparado con a los otros tratamientos.

El sustrato desempefid un papel importante en el crecimiento de las raices, ya
gue se observaron diferencias tanto en el medio M, donde las plantulas inoculadas
formaron el fenotipo caracteristico de las raices en cabellera, mientras que la
agrolita favorecio el desarrollo de raices verdaderas y lignificadas con gran

cantidad de primordios.

El sistema de A. rhizogenes, permitié introducir el gen de rolB al genoma de la
planta, ya que la secuencia de 570pb obtenida con los oligonucledtidos disefiados
y su andlisis determind que la secuencia corresponde al plasmido Ri de A.
rhizogenes, comprobando asi la transformacion de las raices. Morfolégicamente,
la bacteria no pareci6 afectar la parte aérea de la planta, asi como su
pigmentacion, no produjo hojas en forma desigual, reducida dominancia apical o

pérdida de geotropismo, conservando sus caracteristicas forestales deseadas.
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PERSPECTIVAS

Debido a que durante la realizaciébn de este trabajo se encontraron algunas

discrepancias en la literatura con otras especies forestales, se propone realizar

estudios posteriores en donde se modifique algunas variables tales como:

Incrementar la temperatura de la camara de crecimiento a 35°C debido a

gue es la reportada como 6ptima para mezquite.

Probar diferentes cepas bacterianas de A. rhizogenes, ya que la
patogenicidad de la bacteria para cada especie vegetal depende de la cepa
bacteriana.

Incrementar el tiempo de co-cultivo de la bacteria y mezquite.

Mantener las raices inoculadas en medio MS ya que favorece la formacion

de raices en cabellera en algunas plantas.

Descartar la contaminacion bacteriana en las raices buscando mas

regiones especfficas de la bacteria tales como virC1y virC2.

Buscar en otras especies vegetales propias del area de estudio el gen rolB.
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APENDICES

APENDICE 1. Secuencia completa del gen rolB de A, rhizogenes K599
TCAAGTCGCCGAGGTTTCTTTCTTCAGATTTACTATAGCAGGCTTCATATCACCCTCTTCACGTTTCTGGTTG
GGTCCCGAGAGCCGCAGGGTGAGGTCTGGCTCCGGTGACGGTACCGCCGGTCGTGGCATCACGCCAGCATTTT
TGGTGAACTGTGTGATGCCGCAAGCAATGACGTCATAGGAGCGGTTTCCAGTGCCTTGCCGCACGAAGAAGGT
GCAGGCTACCTCCCTGCCGTACACATTTGTCACTTTTAACTCCAGCAGGTGAATGAACAAGGTACTTGCAAAA
ATGGCGATAAAACCTTCCAGATCAGGTTCTTCCACGCGGCGGTGCGGCCAAGCAATGTTGTGAGCACGGACCA
TCTCCTGGAGGGCGAGGTCGCTACGATAGGGTTGCATCGTGGTCGCCAGCACGGCCTCTAATCCAAACGTGAT
GGATTTTTCCTCCAGTACTTTCTGCATCTTCTCGCGAGATAGATAGACAAATACATGTCGGTCGTTTTCTCTG
GCCAAATCCGGTTGATCGACAAGCATGGGGGGATGATAACATACTTTGTTTTTTAGAAGATGGGCCAGTTGTT
TAAGTATGACCACCGGCGGACGGTTTTCCTCCAAATCAAGCACGCCTTGGGCCCACCTTTTCTGGAAATCCAT
GAGAGTTTTGCTATAGACTTGGCTATAGATTAAAAATGCAAATTGGATCTCATTGAACAAGTTAAGCTGGTTC
CAGGCTTTTGTGAGATCTCGTGGTTGAAAGCGTTGAAGGAATAGTAATCGAGGAGGCATTGTGATGTGAGGTT
GGGGATAACTGTGGAATAACGGCAAGTTCAGTGCCAT

APENDICE 2. Secuencia completa del gen virD de A, rhizogenes K599
ATGAAACCGTCGGGAAGCTCAAAAACTGGATACGCCGGGTCGGCTAGATCCTCGCCCCAGGTTCGCGCAGGGG
TTACGCCTGTCCTTCATCC CARACACCCTICARCEETTIIGC TTGCTCCCCATCTGACGGCCARATGGATCAC
CGGGAAAATTTATCTGCGCAATTCGCTTACGATGGAATGAGACTGGGCGCAGCCGAGCGGTCCGCGTACGAGA
CATGGGATAGAGCGGACCGGCCGAGTTGGAAAGACCTGATACTGAGCGCTCGCCTGAACGCGATTGACAGTTT
CGCTTGGAATGTCGATGTCGGAGAAAGTACCTCTTCAACTTTTGTTTATGATGGTGTTCCTCTGGCGGAAGGG
GAACGGCATGCCTACGAGGAATGGGTGGAGCCGGGACAGCCCAGTTGGCAACAACTCGTTGTGAACGCGCGTA
TTGAAGAGCTAAACACCTCTGCTGCAATTCCGAATGAGTGTAGTCCCCTTCAAGAGGAATTCCGATCGGAGGC
GCCTAAGCGTAAGCGGACAAGCTCCATTGGTCAAAAGAACGEEITCCCICANCCATICCARTITGATGGGATG
AGACTCGGCTCGCCTGAGCGCGAAGCATATGAGAATTGGAGTAAACCGCAACCGCCATCCTGGAAAGACCTGA
TAGTTGACGCCCGTCTTGACGCAATCGACACCTCCACCTGGCTCAACGAATCAAATGACACCTCGGTCTTCGA
GTACGAAGGCGTCCCGCTTGGGGAGGGGGAACGCCTAGCATATGAAAAATGGCTCAAGCCCGCGCAACCAGGA
TGGGAAGACCTGGTTGTGGACGCACGCGTTGCGGAATTGCACCAGTCTGCTCCGACGTGGTGCGAACACCAAC
CAGGCAACGACGTTTCTTCCAACGAGTCCGGGCGCATCTCGGGCGTCCCAATTAACGCCGAGCAGGTGTCGCG
TGCGTTCTTCGTGTACGATGGAGTGGCGCTCGGAGCAGCCGAGCGCGCTGCGCATGATCGTTGGAGCAGGCCG
GACCGGCCCACCTGGGAAGATCTTATCATAGTCGCGCGCCAAGCTGCTATCGAAGGCGGTGCCGTTTCGAATG
GGATGATCGGGAAGACATCTTCCTCAGTCTTTTTATACGAGGGAATGTTGCTTGGGGATGCGGAGCGTCAGGC
GTACGGACGGTGGAGGCAGCTAGCCCAGCCGCGGTGGCAAAATCTGGTGGTGAACGCGCGCCTGGCAGAGCTC
GACCCGGCGGCCTGGATTCCCGATGAACATGATCCGTCTGAGGATGGCGGGGCGACTGGTCTTCTGTCGCAAG
CAAGCACGACCAATAAGTCCCGCCTCAGTTTAGGTGATCAACCGGAAGCGCGCTCGCCTAGTCTCGCACGTGA
GCCAGCACAACAGCCGACTCACGTGCAAAACCTGACGTGCGCACAATTGGAAGCAAGACGTGCTCTATATTTC
GGGCCCTCTGGGAGGGATGCAGACCARACCGCCAGCATCGCCGACAGTAATCGCCTCGACGAGGTAAGCAAAG
TTAAACGGCTGGGTGCCAAGAGCCGTCGAGGCGCTAAAGCAACGGCCTATGACGTAATTTCAAGTGCGGAAAG
ACTGTCGTCTCACGAGGGTTGTTTGACGGTTCAGTCCACTCAGCCAGAAARAGCCGCTTGCTCGAGAAGCGAC
AATATCGGCACTTATGGAAGTCGAAAAAACGAACGAGCTCGGCTTGCGACCGAGACCGGGAAATACGAGTCGG
AGCATATTTTCGGGTTCAAGGTTGTCCACGATACCCTGCGCTCGACCAAAGAGGGCCGGCGGCTGGAAAGGCC
TATGCCCGCCTATCTCGAATGCAAGGAACTTCATCGACAACATGTTGGTACGGGAAGGGGGCGGACCCGACTG
GTGGGGCGCGGCTGGCCAGATGACGCAAGTTACCGCTCGGATCAAAGGGCAACTCTATCGGACCCTGTTGCGT
CCACGGAAGGTGCAACGGCGTCAAACGGGTATCAATTAAACCAGCTAGGCTACGCACACCAGCTCGCTAACGA
CGGGCTGCAGAGCGAAACGCCAGATGGGGTTATCATGCCGCTTCAGGTCGCGACTACTAGCTACAACTATACG
GTAAGCCGCGATCCGGTACTTTCTCCGCCCAGTAAAGAGCAAGCTCCGGAATTGTTGCACCTTGGGCCACGTG
GCCAGACAGAAGCTGTACTCGCTCGCGAAACAGCATTGACAGGAAGATGGCCAACACGCGAGCGTGAGCAGCA
AGTCTATCGAGAGTTTTTAGCCCTTTATGACGTCAAGAAGGACCTGGAGGCCAAGACACTTGGGTTGCGGAAG
AAAAAAGCTGCGCTTGTTTCCGCGTTGAACCGGACTGCCGCCTCAATAGGCACTTCACCCTTGAAAGCCCAAT
CGTCGAGCGCAGAAGTTGAAAAAGCAACTCACGAGTTTGATGAACGACGGGTTTATGATCCGCGCGATCGCGG
TCGGGACAAAGCATTACAACGGTGA
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Longitud
Mean n Std. Dev
2.19818 10 1.302429 Control
3.49699 10 1.109396 Ar
3.66379 10 1.260093 AIB
4.03292 10 1.077540 Ar+AlB
3.34797 40 1.341786 Total
ANOVA
table
Source SS df MS F p-value
Treatment 19.131091 3  6.3770303 4.49 0.0089
Error 51.084071 36 1.4190020
Total 70.215161 39
Post hoc analysis
p-values for pairwise t-tests
Tukey simultaneous comparison t-values (d.f. = 36)
Control Ar AlB Ar+AlB
2.19818 3.49699 3.66379  4.03292
Control 2.19818
Ar 3.49699 2.44
AIB 3.66379 2.75 0.31
Ar+AlB 4.03292 3.44 1.01 0.69
critical values for experimentwise error rate:
0.05 2.70
0.01 3.35
Comparison of Groups
7.00000 -+
6.00000 - . . ¢
5.00000 -+
3 .
4.00000 -+ 3 % s L
1 - :
3.00000 - ¢ } 3 :
. ¢ .
2.00000 . :
1.00000 - 2
*
0.00000
Control Ar AlB Ar+AlB
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No. De primordios
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Mean n Std. Dev
1.40146 10 1.019758 Control
2.27310 10 1.677640 Ar
2.53161 10 1.049321 AIB
3.36119 10 0.818152 Ar+AlB
2.39184 40 1.341303 Total
ANOVA
table
Source SS df MS F p-value
Treatment 19.541213 3 6.5137377 4.63 0.0077
Error 50.623469 36 1.4062075
Total 70.164682 39
Post hoc analysis
Tukey simultaneous comparison t-values (d.f. = 36)
Control Ar AlB Ar+AlB
1.40146 2.27310 2.53161  3.36119
Control 1.40146
Ar 2.27310 1.64
AIB 2.53161 2.13 0.49
Ar+AIB 3.36119 3.70 2.05 1.56
critical values for experimentwise error rate:
0.05 2.70
0.01 3.35
Comparison of Groups
7.00000
6.00000 -+ .
5.00000 -
4.00000 -+ :
* z *
3.00000 - b4 . b4 .
* b2 = *
200000 + ¥ . .
1.00000 + *
* * *
0.00000
Control Ar AlB Ar+AlB
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Area Foliar
Mean n Std. Dev
2.5125 10 0.88458 Control
3.5860 10 1.33925 Ar
4.7325 10 1.55970 AIB
3.8431 10 1.16363 Ar+AIB
3.6685 40 1.45287 Total
ANOVA
table
p_
Source SS df MS F value
Treatment 25.05723 3 8.352411 5.25  0.0041
Error 57.26492 36 1.590692
Total 82.32216 39
Post hoc analysis
Tukey simultaneous comparison t-values (d.f. = 36)
Control Ar  Ar+AlB AlB
2.5125 3.5860 3.8431 4.7325
Control 2.5125
Ar 3.5860 1.90
Ar+AIB 3.8431 2.36 0.46
AIB 4.7325 3.94 2.03 1.58
critical values for experimentwise error rate:
0.05 2.70
0.01 3.35
Comparison of Groups
8.0000
7.0000 + %
*
6.0000 -+ A
5.0000 - * £ .
* ¢
4.0000 + . * : RS
= &
3.0000 s + .
T *
2.0000 -+ - 4
3 . *
1.0000 - .
0.0000
Control Ar AIB Ar+AiB
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ANEXOS

ANEXO 1. Formulacién del medio YEB

YEB Liquido (250ml) YEB Solido (250ml)
Levadura 0.25 g Levadura 0.25 g
Peptona 1.25 g Peptona 1.25 g
Caseina 1.25 g Caseina 1.25 g
MgS0,0.1225 g MgS0,0.1225 g
Sacarosa 1.25 g Sacarosa 1.25 g
*Rifampicina 12.5 mg *Rifampicina 12.5 mg
Agar 1g

Ajustar pH a 7.2
Esterilizar

* La Rifampicina se agrega después de esterilizar

ANEXO 2. Formulacion de medio Minimo (M)

Macronutrientes mg litro-*
KNOs3 80
MgSO,. 7H 731
KHoPO4 4.8

KCI 65
Ca(NO3)2. 4H,0 288
Micronutrientes

ZnS0Oy4. 7H0 2.65
H3BO,4 15

KI 0.75
Na,MoO4. 2H,0O 0.0024
CuS0g4. 7H,0 0.13
MnCl,. 4H,0 6.0
Fierro

NaFeEDTA 8.0
Suplementos organicos

Tiamina - HCI 0.1
Acido Nicotinico Ac. libre 0.5
Piridoxina — HCI 0.1
Glicina 3.0

Myo — Inositol 50.0
Sacarosa 10,000.00
Agar 3,000.00
pH 55
Esterilizar

63



Hernandez ReséndizJaime

ANEXO 3. Formulacién de Solucion nutritiva Hoagland

Macronutrientes g litro-1
KNO3 10.11
KH2PO4 2.72
Ca(NO3)2 16.41
MgSOa. 4.8
Micronutrientes

H3BO4 2.86
MI’IC|2 4H,0 1.81
ZnS04. 7TH20 0.22
CuSO,. 5H,0 0.08
H2M004 Hzo 0.02

ANEXO 4. Medicién de raices (longitud)

ImageJ v1.46 es un software de edicion, andlisis y procesamiento de imagenes.
Asi como el célculo de areas y estadisticas del valor de los pixeles en selecciones
definidas. Puede medir distancias y angulos, crear histogramas de densidad y
trazos de lineas perfiladas y dispone de calibraciébn espacial para medir

dimensiones del mundo real en unidades como los milimetros.

1. Se fotografié la plantula extendiendo su raiz sobre una escala de 0.5cm.
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2. Ejecutar el programa ImageJ v1.46 y abrir la imagen deseada mediante el menu
“File > Open”. Una vez abierta la fotografia, se selecciona la herramienta “Straight

Line” y se traza una linea sobre la imagen para establecer la escala.

File Edit Image Process Analyze Plugins Window Help

mifelf=]ls, P Z4RRNPNEN VP UL PAL-Y

x=1208, y=1366, value=51,40,36

3. Para establecer la escala se selecciona el menu “Analyze > Set Scale” la cual
abrira una ventana de dialogo donde se cambiaron los parametros “Known
distance” que equivale a 0.5, “Unit of length” a cm, se activa la opcién “Global”’ y
finalmente “OK”.

4. Con el botén secundario, seleccionar la herramienta “Segmented Line” y trazar

una linea a lo largo de la raiz de la cual se quiere obtener la longitud.

{| File Edit Image Process Analyze Plugins Window Help

ol wn Al o] 2] |efss/s|a] | | [>]

Straight Line

Straight, *segmented*
4 ==lv Segmented Line

Freehand Line

jws (right click to switch)

Arrow tool
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5. Para obtener la longitud en cm, se debe seleccionar el menu “Analyze >
Measure” con lo que se desplegara una ventana de dialogo la cual contendra la
longitud de la raiz. Sin cerrar la ventana de dialogo, se llevaron a cabo las

mediciones de las raices restantes de la imagen siguiendo los puntos 5y 6.

ar + aib (B).JPS { Image)

Yol nlFile Edit Image Process Analyze Plugins Window Help

[mifelfzfis /3 Z4E ARNVNENIvIPAMIEALIPALY

File Edit Font Results
[area [Mean  [Min  [Max  [Length |
0.164 125697 19.048 237.702[ 1671
0582 141919 10341 233951| 5927

Numero de primordios

Ejecutar el programa ImageJ v1.46 y abrir la imagen deseada mediante el menu
File > Open. Abierta la fotografia, seleccionando la herramienta “Multi-point Tool”
se marcan los primordios a lo largo de la raiz. Para obtener el nimero total de
primordios se debe seleccionar el menu “Analyze > Measure” con lo que se
desplegara una ventana de dialogo el cual contendrd el nimero total de

primordios.

g Image) 1
File Edit Image Process Analyze Plugins Window Help

ol ola|o|<|<E alalols] |/ s]a)]

3 S : Point Tool
Point or *multi-point* selections
g |area [Mean [Min [Max [x v | A

177 177 177 1737 1478
143 143 143 1670 1487
168 168 168 1838 1421
180 180 180 2008 1431
160 160 160 1765

Dev
>

g Bk W KN =
o oo oo
m
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ANEXO 5. Extracion de ADN bacteriano.

1. Centrifugar brevemente suspensiones bacterianas y re suspender cada paquete
en 200 pl de buffer TE (Tris-HCI 10 mM pH 8, NaEDTA 0.1mM). Agregar a la
suspension bacteriana 200 ul de solucién de lisis 2X (Triton-X 100 4%, SDS 2%,
NaCl 200 mM, Tris-HCI 20 mM pH 8) mas 10 ul de enzima Proteinaza K (10
mg/mL).

2. Agitar suavemente las muestras e incubarlas durante 30 minutos a 55°C.

3. Mezclar la suspension con medio volumen de Fenol-Cloroformo-Alcohol
iIsoamilico (24:24:1), agitar por unos segundos y centrifugar 5 minutos a 10,000

rpm.

4. Separar la fase acuosa y mezclarla con 200 ul de Cloroformo-lsoamilico (24:1),
agitar por unos segundos Yy centrifugar 5 minutos a 10,000 rpm. Se separa la fase

acuosa y mezclarla 200 ul de Acetato de amonio 7.5M.
5. Dejar reposar la mezcla en hielo durante 10 minutos. Centrifugar 5 minutos a
10,000 rpm y si existe algun precipitado, pasar la mezcla a un tubo nuevo y

agregare 400 pul de Isopropanol.

6. Dejar incubando la muestra a -20°C durante 2 horas para posteriormente

centrifugar 5 minutos a 10,000 rpm.
7. Enjuagar las pastillas de ADN obtenidas con 1mL de Etanol helado al 70% y
centrifugar 5 minutos a 10,000 rpm. Decantar el Etanol y secar hasta su total

evaporacion. Resuspender en 20 pl de Buffer TE.

8. Comprobar la presencia de ADN en un gel de agarosa.
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ANEXO 6. Protocolo de extraccion con ZR PLANT/SEED DNA KIT ™

1. Antes de comenzar se debe preparar la columna Zymo-Spin™ [V-HRC Spin
Filters (tapa verde). Se retira la base, se coloca en un tubo colector y se
centrifugar a 8,000 x g, durante 3 minutos para eliminar polisacaridos y
polifenoles.

2. Macerar 150mg de tejito en nitrogeno liquido, transferirlo al tubo de lisis ZR
BashingBead y agregar 750ul de Plant/Seed DNA Binding Buffer. Agitar en vortex
durante 1 minuto.

3. Centrifugar a 10,000 x g durante 1 minuto y transferir 400 el sobrenadante al
tubo Zymo-Spin™ IV Spin Filter (tapa naranja) en un tubo colector y centrifugar a
7,000 rpm durante un minuto.

4. Afadir 1,200ul de Plant/Seed DNA Binding Buffer al filtrado en el tubo colector y
mezclar.

5. Transferir 800ul de la mezcla a la columna Zymo-Spin™ Il Column en un tubo
de colecciony centrifugar a 10,000 x g durante 1 minuto.

6. Eliminar el eluido y repetir el paso anterior.

7. Anadir 200ul de DNA Pre-Wash Buffer al la columna Zymo-Spin™ Il Column en
un nuevo tubo de colecciony centrifugar a 10,000Xg durante 1 minuto.

8. Anadir 500l de Plant/Seed DNA Wash Buffer a la columna Zymo-Spin™ I
Column y centrifugar a 10,000 x g durante 1 minuto.

9. Transferir la columna Zymo-Spin™ Il Column a un tubo de coleccidén nuevo y
afnadir 50-100ul de DNA Elution Buffer directamente sobre la columna y centrifugar
a 10,000 x g durante 30 segundos para eluir el ADN.

10. Transferir el eluido de ADN al tubo previamente preparado Zymo-Spin™ IV-

HRC Spin Filters y centrifugar exactamente a 8,000 x g durante 1 minuto.

ANEXO 7. Gel de agarosa 1% (20 ml)

Agarosa 0.20g
Agua Bidestilada estéril 18ml
Buffer TBE 10x 2ml
Bromuro de etidio 1mg/ml
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